Photoshop 4.0 Tips & Tricks

Some familiarity with the Macintosh
and Photoshop 4.0 is very helpful.
We also assume you have a previ-
ously created, scanned or other
image to open.

In addition to working with multiple
image layers, adding an adjustment
layer and repositioning layers in the
layers window. You will also learn
how to select parts of an image,
save selections and add a layer
mask to an image layer.

Other Related Collage Instructions
1. Simple Collage

2. Montage Of Images

Turned Into An Image Map

Seamless

Collage
Image




Photoshop 4.0 Tips & Tricks

About This Collage

In this example, we used three images and blended them together seam-
lessly to make a fun semi-believable, but false image.

These images were aquired from the CD which came with the “Photoshop
3.0 Wow Book.”

1. Select And Open All Your Images
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Open all your images in Photoshop. T Thesooto 6ot on)
In this case, we have three images open at once. -

T

Landscape Pt @ 66.7% [[.ﬂl’_‘l' ,I'!RJ
I 2 3

=

e i

|

PG @ 66.7% (IIGB _ ehmnes  Fatie
(a1~

W 4

2. Resize Images If Necessary |

To have the ir_nages behave properly, it's _best to L LU | oyger ‘E";j:__:_";;_*;_; ooy
have all working files in the same resolution.

Check each image’s resolution by:

Adjust

Landscape PG @ 66.7% (Layer 0, RGR)

Duplicale... i lmng_e Size

Apply Image... |

Image MeﬂU = Image S|Ze Calculations... Pinel ?lmenns 94!4
The Images Size window appears. et N (= ) g (acar)
crop Height: [480 | (pinets_[+)
Change settings to the desired resolution and moate comvas > e
dlmenSIOnS Histogram... Width: (nches Tv]
[ (e _T5) Ts

Height: |5.2 inches iv|
i | Resolution: (pinets/inch =] |

Constrain Proportions
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3. Check Image View

Be sure that working files are being viewed in the SEE S
|Thegoat @ 66.2% (1GB) |
1 [ _

same percentage value.

If one is at 66.7% view, they should all be at
66.7%. How large your image is and its resolu-
tion will determine how it will first appear on the
display. The larger the image dimensions and res-
olution, the smaller the opening view.

Note: Double clicking on the magnifying glass tool
is a short cut to 100% image view.

(Forms )

Page 1

Goat
Collage




Photoshop 4.0 Tips & Tricks

| wanted to fine tune the Target or Background o e et S
Layer of the image before adding the other images -
to it.

a. Add an Adjustment Layer by moving the cursor
to the Layers Window.

b. Click on the arrow in the top right of the

Layer Window Qw0 expose the Layer Option
selections. The Layer Options become available.
c. Drag down to New Adjustment Layer (2]

The New Adjustment Layer ©a window&opears.
| chose a new Levels Adjustment Layer.

= ayer Options...
Merge Disible
Flatten Image

Palette Dptions...

kb
THETmT &

New Adjustment Layer

) e

New Adjustment Layer =——————
Type: ([Tevels = T—
* Levels
Opacity: | curves [~] L
Brightness/Contrast Type:
Color Balance er ea opacity: [100] % Mode: e
Hue/Saturation [ Group With Previous Layer

Selective Color

Invert
Threshold

Dnctariza

-Em l.el::als E Channel:
~— Channet: (A58 [¥)- () Input Levels: 1.15 ]
AT A] Output Levels: [0 | [255 |
output Levels: [§ ] [F55] At | xpreview

[ Preview

I moved the dark control over to the right and the light control to the left. | moved the
mid-tones to the left just a little to lighten them.
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Adding Images To The Background Image

Arrange the images in such a way as to have the
source images, the ones you want to move to the
Target Image, and the Target Image visible on the
screen at the same time.

a. Using the Move Tool O and working in the
Source Image
b. Drag the image off its canvas and on to

the Target Image’s Canvas

Dotted lines appear arounghe image to indiciat-
ed that you are moving it.

If done properly, the image will appear in the Lay-
ers Window on top of your background image.

Continue adding images in this mannor until all
images have been added to your base image
canvas.

The last image added to the base canvas is at the
top of the Layer Windows list.
The top layer is hiding the ones below it.

Select A Layer and Tempoatril

Decide which layer you're going to work on first.
| wanted to work in the Goat Layer first, so |
turned off the Earth Layer.

In the Layers Window, turn off the unused layer
by Clicking on the Eye Icon next to that Lay-
ers Icon.

| wanted to keep the goat and the hillside but
wanted to remove the gray backgroynd. Check to
be sure your target layer is active.

a. Select the Magic Wand Tool 2] by double
clicking on the Magic Wand Icon to bring up_its
controls window. | used a tolerance of 25.

b. Continue selecting portions of the back-
ground by: Holding down the Shift Key and click-
ing in another area. This keeps the previous
selection and adds the newly selected area to it.
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Note: you may need to fine tune your
selection by decreasing the tolerance level
or choosing another tool to complete the
selection. Working in a view of 100% or
more also helps you fine tune the selection.
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Image Selection And Layer Mask Continued

. . . 1 [
c. Using the Lasso Selection Tool & and holding | [T o

[C5ampss berged

down the Shift Key will allow you to add your
selection, letting you pick up and add stray pixels.

Note: Holding down the Option Key while making
a selection will Remove that area from the selec-
tion. In the goat image, the horns were captured

along with the background.

| used the lasso and the option key to remove the
horns from the selection.

7a. Once the selection process is complete, the background selection must be Inverted.
Using Inversion will cause the goat and its hill to become the selected area.

a. Select Menu and drag down to Inverse.

The goat is now the selected area. Notice in the illustration below how the outer edge of
the background A is no longer selected. O shows that the goat and the bottom of the hill is
now now the selected area.

Note: Since the selection process can be time consuming, saving your selections is a good
habit.

4 Filter Uiew

{ Color Range...

Feather... (%D
Modify

Grow

Similar

Load Selection.
Save Selecti

7b. To save a Selection with the selection active:

Under the Select Menu, drag down to Save Selection. The Save Selection Window
appears.
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aving A Selection Continuec

Note: Since this is the first saved selection, it will become number 4 in the Channels List.
Other saved selections will also be added to this list in numeric order.

mage Layer I3 Hilter Liew Window

an =————— | oad Selection

None

E Inverse E Source
Color Range... foers. Document: [ Landscape.JPG | ]

Feather... a8 Channel: [ Zoyar J Bronsperency |~
/ » fagyer [ Fransparency

§ Similar > — Operation ~ -
i Load Selection... | @® New Selection
save Selecti w : O Rdd to Selection

(& Subtract from Selection
O Intersect with Selection

AEsm

| Feathering A Selection

Sometimes the selected edges look too harsh. Using the Feathering Option can help blur the
edges just enough for a good visual blend. Applying too much feathering can make the image
look too soft around the edges. Experiment with feathering your selections to see what looks
best for your image.

1T Filter View Window

7c. To Feather the edges of your selection

A

a. Under the Select Menu, drag down to Feather. :Illlne :g
The.Feather Radius Window appears. . Inverse  oxl l66E ayer 1, RGB)
b. Key in the desired amount of feathering. In this A anallanan ol tananels
example, a radius of 1 was used. Calor-Rangs .
2 d = ik 1)
Modify 3
Grow
Similar
Load Selection... '
Save Selection... ¥

S oy iy ¥

7d. Adding A Layer Mask —LurEeChRe D T et ), Layer presy)

Check to be sure Black is the Foreground Color B A W e ——
and that your selection is still active. o 5 o e

a. Go to the bottom of the Layers Window and : ' RN © &
click on the Layer Mask Icon. NG HE

b. The Layer m@k Icon appears next to your o B[ [ Juvadioermsk uiuin
goat layer icon. ¢ O = T
Once the Layer Mask has been added, the land- - @\ L
scape image shows through the background - ETeTE

selection of the goat layer.
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8. Fine Tuning The Layer Mask

Sometimes when the Layer Mask is applied to your selection, noticeable artifacts or

halos (

a), may become visible around your image. These artifacts can easily be

removed by painting on the Layer Mask with one of the painting tools.

Selecting black O asthe Foreground Color will add to the mask, taking more away
from the image. White as the selected color will remove the mask, revealing more of
image behind the mask (the gray background in our case).

This image has a noticeable gray halo around the

goats back and in the horn area.

a. Be sure you're worki
The Layer Mask Icon

the Layer Visibility Icon (the eye) and the Image

in the Layer Mask.
will be visible between

Layer Icon (the color image of the goat).

Note: If the Paint Brush is visible next to the layer

icon, click your mouse on the Layer Mask Icon to

activate the Mask.

b. In the Tool Box, choose the Air Brush. (2]
Select a brush size appropriate to the area you
are going to be working in. In this case, | used a
relatively small brush with a diffused edge.

c. With black as the Foreground Color,
carefully go over the artifact with the brush.

ork in small areas to keep errors to a minimum

a. Remember to use the Command and Z

keys to undo errors.

Note: Remember, you can correct bad mistakes
(for instance, removing more of the image then
you planned to) by painting on the Layer Mask

with white.

Hide Tools

Ij

s o
3 & U Ol

=it andscape.JP6 @ 200% (Layer 1, Layer 1 Ma

!

= IS NN
E = ENFE RN EES
|
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]
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Show Navigator
Show Info
Hide Options

Color \{ Swatches \{ Brushes 4

Show Color
Show Swatches

Show Brushes

Hide Lauers

9.

* L]

R B
....g

35 45 &5 | 100

. .

Click to choose Brush
=R :

Revealing The Earth Layer

The earth layer is still turned off. Turn it on again by:
Clicking on the blank square in front of the Image Icon in the Layers window.
As you can see, the Earth_Image is too large for our composition.

See image on next page.
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10. Scaling The Earth Layer

Be sure you are working in the target layer (it will

be highlighted in black).
With the Earth Layer selected:

a. Go to the Layer Menu, drag down to Trans-
form and over to Numeric. The NumericTrans-

form window appears.

b. If the Position and Scaling Options have x's
in their boxes, Deselect them by clicking on and

unchecking them.

c. With the Scale Box Option selected (a check
in the box), activate the Proportions Box, so it
has a check. This will force the image to be

reduced evenly in all directions.

d. Key in the percentage of scaling. This image

was scaled 75%.

: Numeric Transform :

K11 Select Filter UView Window

New » | :

Duplicate Layer...
Delete Layer

Layer Options...
Adjustment Options...

Add Layer Mask > |
Enable Layer Mask

Group with Previous #G6
Ungroup {0

Free Transform T |

Scale
Rotate
Skew
Distort
Perspective

Arrange »

Merge Down HE
Merge Disible GHE
Flatten Image

Numeric... O%T |

Mattin »
Ratata ane rim

H: [
v: [0 | (pixtels [~]
Relative
[ Scale
width: [100 | [ percent [~]
Height: [100 | [ percent [~] ]@

Constrain Proportions

|

Cancel

= Numeric Transform :

[ Position
H: | (pirels [~]
v: | (pirels [~]
Relative
|-|2|Scale- |

width: |75 | (percent [~]

c

Height: |75 | (percent [~] 'J

| [® Constrain Proportions |

i [x] Skew | [l Rotate 1 - Skew - - [ Rotate- |
A ° .
Vertical: D’ | | Vertical: D°

Select The Earth Layer Background

|e Layer JECICTHM Filter  Diew

Still working in the Earth Layer (1} s

a. Use the Magic Wand to select the background
of the Earth Laye,r adjusting tolerance as needed.

Color Range...

Feather.. =0

Using the same selection techniques as used petiry
in the goat layer, fine tune the selection with the Teg| e
Lasso Tool and modifier keys as necessary.

| Load Selection

Lasso and the Shift key to add a selection, Lasso 1] g tion
and Option to deselect from the selection.

b. Inverse the selection;
c. Save selection for later use; and
d. Feather the selection one pixel.

Page 7
Goat

Collage




Photoshop 4.0 Tips & Tricks

12. Add Layer Mask And Re-order Layer

Add the Layer Mask

a. With the Earth Layer still active, add a Layer Mask. The background disappears
and the layers below show through.

b. If necessary, use the Air Brush Tool in the Layer Mask to clean up any artifacts
that may remain on the image.

The earth layer is the first layer in the Layers
Window. It is blocking the goat image. What we
really want is the Earth Layer positioned in
between the Goat Layer and the Landscape
Layer.

To move the layer in the Layers Window:

a. Select the Move Tool ©;

b. Select the Earth Layer and drag it below the
Goat Layer.

The Earth is now in the proper orientation in our
composition.

The Earth Layer is lower in the sky than we want,
so we need to move it higher in the sky. Check to
be sure you are working in the Earth Layer.

c. Using the Move Tool, click on the Earth's
image in the Canvas Window and drag it into a
higher position in the sky.

(o1 R 2 O N 4
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